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This page is written with Microsoft Outlook Express [OE] 6.0 Email browser in mind.
However, many of these tips and pointers will work with other Email browsers, also.
The information in this page is designed to help you become an efficient and effective user
of Email by showing you some tips and pointers of mostly a cosmetic rather than a
technical nature. For matters pertaining to obtaining the Email services of an Internet
Service Provider [ISP] and getting connected, you need to select an ISP and get your
technical information from that ISP.
By the time you read this, XP and Outlook Express will be on the trash heaps of history.
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Introduction
Email is here to stay and is a key component of the digital revolution. You can learn to use
Email even though you've never touched a typewriter. And, age is not a factor. My
Mother-in-law is approaching 90 years of age and had never touched a typewriter before
2001. However, she now uses Email regularly to correspond to her extended family and
you can, too. She may type slowly and likes to use fonts of at least 24 points, but her
messages are clearly understandable. My wife gave her parents a computer she had
outgrown, thinking that her Dad would be the primary user, since he already knew how to
type. However, Nancy's mother took an interest in the computer and has soaked up
everything we have been able to teach her about the Internet and Email.
Being able to type is a definite plus when it comes to using Email with ease and efficiency.
I have my Dad, Rev. J. Franklin Lint, to thank for the degree of typing ability I may have.
I can still remember him going head to head with the high school principal back in the
early 50s about my taking typing. The principal thought I didn't need typing because I
was in the College Prep course and not the business course. Of course, Dad said, "He of all
people needs to take typing because he's going to college." Dad seldom lost an argument
that involved logic and he didn't lose that one, either!
I started using Email in October, 1981. Since then, I checked my Email every working day
until I retired in December, 1994. Since retirement, I have checked my Email every day,
including weekends and holidays. I check my Email the first thing when my computer
boots up in the morning. And, the last thing I do before putting my computer to sleep in
the evening is check my Email.
When I came home from the hospital in May 1996, following quintuple heart bypass
surgery, the first thing I did was read my accumulated Email, and [with my wife's help]
respond as needed.

Check your Email regularly.
Have you ever heard of anyone who didn't check their USPS mail box daily? I haven't! As
soon as the mail delivery person walks/drives away, we're right there, checking to see
what we got. Most often, it's catalogs and bills.
We need to give our Email this same level of diligent devotion. Check your Email
at least once a day. I check mine several times a day.

Activate the Spell Checker.
For some strange reason, off is the default setting for the spell checker instead of on.
Therefore, you have to take the proactive step of turning the spell checker on. Never

assume you are a good enough typist or speller to ever send an Email without activating
your spell checker. The OE spell checker is not as powerful as the one in your favorite
word processor but it will catch all of your spelling errors if not your grammar errors.
1.
2.
3.
4.

Get the Inbox window on the screen.
Pull down the Tools menu and select Options.
Click the Spelling tab at the top of the screen.
Make sure the following options are checked:

•

Always check spelling before sending
Suggest replacements for misspelled works

•

Activate Rich Text Format [HTML]
Outlook Express gives you a choice of two typing formats: Plain Text and Rich Text with
Plain Text being the default setting???
Plain Text Format: This is just plain vanilla with no chocolate and no sprinkles.
Rich text Format: This format enables you to format the text of your message with such
things as bold, italics, and color. In fact, most of the text formatting features available in
your word processor are available. Most important is the ability to add pictures, both in
line with your text or as attachments to your message.
To activate Rich Text format:
1. Open Outlook Express [OE] and get a new message on the screen.
2. Pull down the Format menu and make sure a black dot is showing beside Rich Text
[html] and that a check is showing beside Send pictures with message.
3. If the black dot and check are not showing, select them successively and these
features will be activated until you deactivate them at some future date.

Use Your Address Book.
Before you can use your OE address book, you need to understand some rules about
Email addresses:
An Email address is composed of two basic parts separated by the @ symbol. The @
symbol is made by holding down the shift key and typing the numeral 2. Usually all
characters of an Email address are in lower case and there may be no spaces. Most people
accept this rule and learn to read and write Email addresses according to it. But if you
don't like to see yourname, you can use an underscore instead of a space: your_name

The information to the left of @ is how you wish to be identified [User Name] and the
information to the right of @ is the Internet service that is providing you with Email. Here
is my business Email address as an example: diskbooks@comcast.net
Email is absolutely unforgiving of any typos. If you make a mistake in the way you type
the address, your Email most likely will go nowhere except into the ozone layer. The
unforgiving nature of Email is the main reason for using your address book to both send
messages and store addresses.

Adding addresses to your address book by typing.
1. Open OE without a message showing. You will see a button marked Addresses at
the top of the screen. Or, when a message is showing, pull down the Tools menu and
select Address Book
2. Click the New button and select New Contact. [OE will call the persons listed in the
address book Contacts]
3. Fill in the name fields with how you want your mail to appear when your contact
gets it. Let's say you are planning on writing to your parents. You could put Mr.
and Mrs. John Doe in the name fields. Or you could make it sound more personal
and put in Dad and Mother. I have chosen to put in Dad and Mother.
4. You will need to know the exact spelling of your parents' Email address. I know my
parents' Email address is johnmarydoe@ptd.net Therefore, I carefully type this in
the Email addresses field and double check it to make sure there are no typos.
5. Click Add and then click OK. You have just added Dad and Mother to your address
book. When you write to them from now on, just start typing Dad and Mother in
the To: field. If you only have one address beginning with D, all you have to type is
D. But if you have several starting with D [Dave, Donna, Dean, etc] you will have to
keep typing Dad and Mother until you get to the point where OE recognizes Dad
and Mother. In this example, you would have to type Dad before OE would take
over and complete the addressing for you.
6. Remember: when you type in the address in the To: field, start slowly typing their
real name, not johnmarydoe@ptd.net That is their Email address but OE translates
Dad and Mother into johnmarydoe@ptd.net
7. Have faith and do it this way. It really works!
8. Now you are ready to add another address to your address book.
Special Note: If you are having difficulty getting your copy of OE to work as described on
this page so far, try this:
•
•
•
•

Make sure you are at the OE Inbox page.
Pull down Tools and select Options
Click the Send tab
Read all the options at the Send tab and make sure everything is checked the way
you want it to be.

Automatic additions to your address book:
So far, you have learned how to type an address for Dad and Mother. But, today you get
an unexpected Email from Aunt Elizabeth. OE will automatically add her name to your
address book if you reply to a message from her. Today, you also get a message from a
business associate that needs no reply. You can also add this address to your address book
without typing it in:
1. Look at the message carefully. At the top of the left side of the message, you should
see the word From: with this contact's name beside it.
2. Double click on your associate's name and OE will give the first screen of the
Properties of this person's Email information.
3. Click on the Add to Address Book button and your business associate will be added
to your book!

Creating Groups in your address book.
A Group in an OE address book is a list of contacts that is saved under a certain name you
create. If you find yourself sending the same Email message to people with common
properties or characteristics, you need to create a group. For example, here are two
groups I have in my address book. Ed Lint Family and Big Family. The first is made up of
my wife, my four children, and any of the spouses who may have their own Email
addresses. Big Family is everyone on Nancy's and my sides of the family that have Email
addresses. For example, if I want to write to my immediate family, I click in the To: field
and start typing Ed Lint Family. At the present time, all I have to type is the E and OE
finishes typing Ed Lint Family. I write my message and click Send. Bang! Everyone in our
immediate family gets the message. To create a Group, follow these steps:
1.
2.
3.
4.

Open your Address Book and select New and New Group.
Give your new group a short name. In this example we'll call it Family
Click Select Members
All contacts currently in your address book will be in the left column. Everyone in
the Family group will appear in the right column.
5. Click a name in the left column to highlight it. [Or, double-click a name in the left
column.]
6. Click the Select button in the middle and it will appear in the right column as a
member of your Family group.
7. If a contact appears in the Family group in error, click on it to select it and then
press the Delete key on your keyboard.
8. When you are finished adding contacts to your Family group, click OK and you will
be able to see your Family group in a Properties window. Look at it closely and
make sure it's the way you want it to be.
9. If it is, click OK and close out of OE before you try to use your new Group.
10. The next time you have a message to send to your whole family, type Family in the
To: field and it will go to all you have placed in this group. Family is used here as an

example. You can have groups called such names as Teachers, Students, Board
Members, Customers, Friends, etc, etc.

Creating and Using a Signature
A signature is a saved block of text that you use any time you need to paste this block. This
feature is called Signature because it is frequently used to close an Email message. You
can create and use Signature by following these steps:
1. Make sure the OE screen is showing Create Mail in the upper left corner of the
screen.
2. Click on the Create Mail button to get a blank message form. Type the block of text
you wish to use as your Signature in the message block of this blank form.
3. Select [highlight] the text in your signature and copy it to the clipboard. [Press
Control-C]
4. Pull down the Tools menu and select Options
5. Click on the Signatures tab along the top of the Options dialog box.
6. Click the New button. Signature #1 will appear in the Signatures box.
7. Click in the Edit Signature box to get an insertion point [flashing cursor.] Also,
make sure the Text button beside this box is clicked.
8. Paste the contents of the clipboard at the insertion point. [Press Control V}
9. Click Apply and then click OK. Your new signature is now stored and ready for use.
10.When you want the signature to appear at the insertion point, pull down the Insert
menu and select Signature.
11.A menu of the names of your stored signatures will be displayed. Click on your
choice and press Return. Your signature will appear at the insertion point.
12.You may rename or remove a signature by returning to the Signature dialog box:
Tools>Option.

Use the BCC [Blind Carbon Copies] Address Field to Keep Email Addresses
Confidential
When you send a message to a group [list], all the Email addresses in the group will be
published for everyone to see. In this age of mass spamming, some folks don't care to have
their Email address put on public display. Here's how you can use the BCC field to keep
the Email address of your recipients completely confidential:
1. With an Email message on the screen, pull down the View menu and select All
Headers. This will cause a check mark to appear beside All Headers. And this field
will be toggled on.
2. The BCC field will now appear between the CC and the Subject fields.
3. Type the Group name and any other addressing information in this new BCC field.
4. Leave the To: field blank when addressing your message.
5. When such a message is sent, Undisclosed Recipient: will appear in the To: field of
everyone who gets your message.

6. The BCC field will not even be seen by the recipients, maintaining complete
confidentiality.

Sending and Saving Attachments
Attaching a file to your Email message is a handy and powerful way of moving
information via the Internet. Evil people have learned it is just as easy to cause damage
and mayhem so beware. We are assuming that the readers of this page want to learn about
attachments for good reasons: To attach file[s] to an Email message:
1. Know where on your computer this file[s] is located. If you have this file buried in a
folder several levels deep in your C drive, it may be a good idea to create a folder on
the desktop for holding files to be attached.
2. Attach the file[s] before you write the message in the message area. I have made the
mistake of clicking Send without making the attachment.
3. With the new message on the desktop, click the Attach button marked with a paper
clip icon.
4. OE will open a window for you to browse to the location of the attachment.
5. If you are attaching more than one file from the same folder, hold down Control and
then click each file to be attached. [When you hold down Control, your selections do
not need to be consecutive.]
6. When your selection[s] has been made, click the Attach button.
7. Now your attachment[s] will show in the Attach window below Subject, along with
the file name and size of each.
8. Now complete the rest of your Email message: To: CC: etc.
Saving attachments: Many attachments you will just read and either file or delete. When
you get attachment[s] you want to save, here's how to do it:
•
•
•

Right click on a file icon in the attachment window
If there is more than one attachment to this Email message, you may elect to Save
All
Follow the prompts very carefully. I suggest you save first to the desktop and then
you can file the attachments where they belong.

Sending Digital Pictures [Using a digital camera]
Sending and receiving pictures via Email is a lot of fun. Of course, the digital camera has
made this not only possible but relatively easy. [Picture phones are not covered on this page.]
A digital camera stores a computer file of a picture on a storage device inside the camera
[Examples: CompactFlash and SmartMedia. ]
These picture files are then downloaded to your computer where they may be printed, sent
via Email, or inserted into a web page. I use an old-fashioned Olympus 2.1 megapixel camera.
[Many newer digital cameras have far more than 2.1 megapixels.] This meets my needs for

sharing pictures with family and friends. I have two 8 mb SmartMedia cards that will hold 16
pictures each at the highest resolution. I also have a 64 mb SmartMedia card that will hold
127 high-resolution pictures. Once the pictures have been downloaded to my computer and
stored on the computer's hard drive, the camera's storage device may be erased and used
over and over again. Digital cameras are hard on batteries so I always carry a spare set of
batteries as well as a spare smart card in my camera case.
Tip: If you frame your pictures through the top viewfinder instead of the LCD [liquid crystal
display] monitor on the back of the camera, you may find your batteries lasting longer. I find
it's easier to rest the camera on your cheek and side of the nose while using the viewfinder,
instead of holding the camera out in front of you and looking into the LCD monitor. [If you
use the viewfinder on top of your digital camera, people may think you are still back in the
dark ages of film cameras.]
Here's the process I use for sending pictures from my digital camera via Email:
1. Download the picture files from the camera's memory to a folder on my desktop I call

pix. Each picture file gets a default extension of .jpg [pronounced JAY-peg]. Your
camera should have a USB cable to enable you to do the download of over 100 pictures
in just seconds. I use a Belkin converter that will accept four different sizes of camera
storage devices.
2. Use the software that came with the camera [Camedia] to resize each picture. At the

highest resolution, the pictures come out of my camera as 1600 pixels wide. It is
possible to send a picture this wide via Email but it will be so large, the recipient will
have to scroll continually to see the whole thing.
o

When printing a digital picture on a printer, more pixels will give you a better
image. However, when Emailing and uploading to a web server, a lower pixel
number will not only make the picture image smaller in size, it will make the .jpg
file size smaller, also.

o

Warning: Resizing jpgs will remove pixels. It may be a good idea to save your new
pictures just as they come out of the camera. When you resize them for email use,
always work with a copy [Save as ...] of an original full-size jpg. Then you will have
the full pixel file to make quality prints.

3. When I first started sending pictures via Email, I made this mistake. My brother said

he loved the pictures but there was just too much of them. That's what brothers are for.
4. By trial and error, I learned that 500 pixels as the greater dimension was just about

right for sending my pictures via Email so that's what I always use. When I change the
1600 to 500, the other dimension changes proportionally. [My monitor's resolution is
set to 800 x 600 pixels. At my age, I like to have my work large enough to see easily.] If
you and all your viewers use higher monitor resolutions, you will be able to use a larger
pixel size without causing constant scrolling.
5. You can also use the software to brighten the picture, if it is rather dark and muddy.

Cropping is possible to cut away parts of the picture that do not contain valuable

content. Do any necessary cropping before you resize down to 500 pixels for the larger
dimension.
6. The last step is to rename the picture with a filename that will mean something to me.

Olympus gives each picture a numeral for a name but I want file names that tell me
something about the content of the picture. For example, the next big event on our
family's calendar is my granddaughter's birthday. Here name is Tori. So the file names
for the pictures of Tori's party will look something like this:
toricake.jpg [Tori's birthday cake]
torigifts.jpg [Tori opening her gifts]
toricandles.jpg [Tori blowing out her candles]
etc, etc, etc.

Including pictures with an Email message
Here's an example of how I send .jpg picture files with my Email messages:
1. Compose an Email message for Big Family that tells about Tori's party and includes
some pictures.
2. Make sure the insertion point is where I want a picture to appear. [Click in the text
field to get an insertion point.]
3. Pull down the Insert menu and select Picture.
4. OE will give me a window where I can navigate to the folder that holds the pictures
of Tori's party.
5. I'll select the picture I want, based on the descriptive file names I see, and bang!
6. The picture will appear in the message, right at the insertion point.
7. This process of inserting pictures in the text of your message is called the Inline
method. You may also send pictures by using the Attach command. Your pictures
will not appear in the text with the Attach method, but they will be displayed below
the text.
There are a few warnings you need to heed when sending pictures in your Email message:
•
•
•

Your ISP or the ISP of your recipients may have limits on the number of pictures
you can send in a single message.
People who use freebee Email [service that is free] may be able get fewer pictures
per message, or none at all.
People who have a dial-up connection to the Internet may need to take a walk
around the block while your pictures download to their screen. If your recipients
have a broadband connection to the Internet [Cable or DSL], the pictures will
appear much more quickly.

Saving pictures: Many pictures you will just look at and either file or delete. When
you get picture[s] you want to save, here's how to do it:

•
•
•
•

Right click on the picture you want to save.
Select Save picture as
OE will give you a Save window with the file name highlighted. While this file name
is still selected, rename it with a name you will recognize in the future.
Make sure you see where OE will be saving the picture; browse to a new location if
you want another one.

Forward with care
Forwarding what you think are valuable messages is easy with Email. Just click the
Forward button and address your message as you would normally do. There is even a
space for typing in any comments you may want to use as an introduction.
However, when you forward the easy way, OE puts a hash mark [>] at the beginning of
every line. If a message has been forwarded to you and you forward it to a bunch of new
people, the hash marks are multiplied. The text becomes increasingly difficult to read
until it's easier to click Delete then try to read a forwarded message.
Not so long ago, I received a forwarded message that had over 100 hash marks on it. You
need to be able to use your computer's clipboard to forward properly.
Here's the right way to forward a message that will be as clean as when you first looked at it:
1. Click in the text box of the message you like.
2. Pull down Edit and choose Select All. [Or press Control-A]
3. This action will select [highlight] everything in the message box.
4. Pull down Edit and Select Copy. [Or press Control-C]
5. This action will copy the entire message that you like onto your computer's
clipboard. You always have to select something before you can copy it.]
6. Create a new message, add the recipient[s] and subject.
7. Click in the text box and make sure you see the cursor flashing there.
8. Pull down Edit and select Paste. [or press Control-V]
9. This action will paste the entire message that you like from your clipboard into your
new message. [>>>No hash marks will be included!>>>]
10.Now, use your address book to send this new, pristine message far and wide. There
won't be a single hash mark in the whole carload!

11.If you want to keep the addresses of your recipients confidential be sure to use the
BCC field for all addresses and leave the To: field blank

Using Your Clipboard to Create a Hyperlink in an Email Message
[Outlook Express is used in this example. If you are using another Email browser,
the routines may be similar.]
A hyperlink [clickable] URL usually will have a line under it. When your mouse pointer
passes over such a link, it becomes a pointing finger. For this reason, you should never
underline text for emphasis. Readers may naturally assume that underlined text means it is a
hyperlink [clickable] link. [Use, bold, italics, or color for emphasis.]
The Internet is very unforgiving when it comes to typographical errors so it is absolutely
essential that you use your clipboard when copying and pasting a URL. I am either a good or
an accurate typist, but never both at the same time.
Follow these steps when creating a hyperlink in the body of an Email message:
1. Make sure you have activated Rich Text Format [HTML] in your copy of Outlook

Express. If you're not sure how to do this, check the tutorial on page 6 above.
2. Get the target page [where you want your readers to go when they click the link] on the

screen.
3. Select the target URL by clicking in the Address Window until the URL is highlighted.
4. Copy the URL to the clipboard.
5. Click in the message window at the point you want the new link to appear. Make sure

you see a flashing cursor: this will be the insertion point for the Paste you are about to
do in the next step.
6. Paste the URL from the clipboard into the message window at the insertion point.
7. Press space bar one time. Your URL will appear with a line under it and it will be a

hyperlink. However, this hyperlink will not become active until your message has been
sent. [See note about sending a test message in Step 13.]
8. Or-- you can imbed a URL into the Message Window by following steps 9, 10, and 11

below:
9. Select the text you want a reader to use as a hyperlink.
10. Click on the Create a Hyperlink icon at the far right of the task bar. [This icon consists

of a globe of the world and a link in a chain.]
11. Outlook Express will give you a window into which you may paste your target URL.

Warning: Make sure you have erased the fragment of a URL OE thinks you need to

help you get started. When you first open this window, any helper text will be selected.
Just paste your new URL on top of the selected text and your text will replace the
helper text.
12. The text selected in step 9 will now be underlined and will be a hyperlink . [Although it

will be underlined, it will not act like a hyperlink until you take the following step.]
13. Send a test message to yourself so you can click on your new link and make sure it

takes a reader where you intended.
14. The hyperlinks in an Email message are not activated until a message has been sent.

Glossary
@: This symbol is part of every Email address and divides the sender's user name from
the domain or ISP that is initiating the mail action. Here is an example:
diskbooks@comcast.net
Activate: The process of making a software feature functional, often by placing a checkmark in a box.
Address book: The place in an Email browser where Email addresses are stored for quick
use.
Attachments: Files or pictures that travel along with an Email message and may be
viewed and saved by the recipient.
BCC: Blind carbon copies; when Email addresses are added in this field, the recipient will
not be able to see where copies are being sent; when a group is placed in this field and no
names are in the To: field, recipients will not be able to tell who else got a copy of the
message.
Browse: Navigating through the folders and disks on your own computer to find a specific
file[s].
Browser, Email: A software program designed to send and read Email messages.
CC: Carbon copies; addresses placed in this field will get copies of this message; recipients
will be able to see the Email addresses placed in this field.
Clipboard: A storage segment in the memory of your computer for temporary storage of
data during the processes of copy, cut, and paste.
Compose: The act of writing an Email message with a browser.
Contact: OE calls the names in your address book Contacts.
Default: The settings of software as the user first sees it before making any changes.
Delete: The act of erasing Email; when the delete key on the keyboard is pressed while
data or objects are selected, they will disappear.
Dial-up connection: Access to the Internet via a phone line and a modem.
Digital pictures: Pictures taken by a digital camera and stored as computer files inside the
memory of the camera; such pictures are usually downloaded to a computer where they
can be used in a variety of way, including inserting in Email messages.

Email: Electronic mail that travels over the Internet and may be read and sent via an
Email browser.
Forward: Sending an Email message to one or more other Email addresses.
Group: A list of Email addresses that share a common interest, such as: family,
coworkers, customers, etc.
Hash mark: The mark [<] the Email browser puts in the left margin of a message when it
is forwarded. Messages that are forwarded repeatedly will become unsightly with
accumulated hash marks.
Hyperlink: Text with an embedded URL that will move you to another location in the
current document or another document. While connected to the Internet, clicking on a
hyperlink may send you to the other side of the world. It's wise to bookmark your current
location before using a hyperlink.
Inbox: The location in an Email browser where incoming Email is first seen.
ISP: Internet Service Provider. Comcast and America on Line [AOL] are ISPs.
Jpg: [JAY-peg] The extension that must be at the end of a Windows jpeg photo filename.
Example: picture.jpg
Megapixel: A measurement to show the resolution capability of a digital camera, as in: 2.1
Megapixels.
Members: The addresses in a specific group in your address book.
Message window: The large text block where you type an Email message.
Name fields: The place in your address book where you type the first, middle, and last
names of your contacts.
Options: This is a selection of the Tools menu that lets you choose the various features
available for Outlook Express.
Outlook Express: [OE] is the Email browser discussed in this page.
Pixel: A pixel (short for "picture element") is one of thousands of tiny spots in a grid on a
display screen or printed sheet. These spots, or blocks, are individually colored in order to
show images on computer screens, and represent the smallest elements that may be
manipulated to create graphics. © Microsoft Corporation. All Rights Reserved. "Pixel," Microsoft® Encarta® Encyclopedia 2000. ©
1993-1999 Microsoft Corporation. All rights reserved.

Properties: The characteristics of a contact in your address book.

Rename: Changing the file name of a picture from a series of numerals to a meaningful
word.
Resolution: The degree to which a digital picture looks crisp and sharp.
Resize: Removing some pixels from a full-size jpg file so it can travel with Email. 500 pixels
along the greater dimension is a good size to start with. Resizing makes the size of the image
smaller while reducing the size of the computer file that carries the pixels. When you make
one dimension 500, the other will change proportionally.
Rich Text Format [HTML]: In OE, this is the ability to format text in much the way you
would do with a word processor. The opposite of Plain Text.
Scrolling: When an image is too large for the screen, scroll bars appear at the edges of the
screen that let you move the image so you can see all of it.
Select: Highlighting text or an object so the computer can work with this selection in some
way.
Send: The button on your Email browser that lets you send an Email message on it's way.
Signature: This is a saved block of text that you use any time you need to paste this block.
This feature is called Signature because it is frequently used to close an Email message.
You create a new Signature by accessing the Tools>Options menu. You can access your
stored Signatures by pulling down the Insert menu.
Smart card: A memory device inside a digital camera that stores the jpg files that make
up pictures. An 8 mb card will hold about 16 pictures at high resolution.
Subject: The field where you give a short description of the contents of your Email
message. It's considered poor form to leave it blank or always use Hi as your subject.
Tab: The selections across the top of a screen where there are several submenus to choose
from. In OE, the Options screen has numerous tabs such as: Spelling, Read, Send,
Signatures, etc.
To: The field where you type the Email address of the recipients of your message; multiple
addresses may be placed in this field, separated by a semicolon; OE will complete an
Email address as soon as you type enough characters to make it unique for all the contacts
in your address book.
Tools: One of the menus at the top of the Inbox screen of OE.
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manager at the Laurelton [PA] State School, and 15 years as Special
Education Adviser for the Pennsylvania Department of Education in
Harrisburg.
Throughout his secular career, he has remained active in Christian service in a variety
of capacities: Sunday school teacher, Sunday school superintendent, teacher trainer,
director of Christian education; choir member, choir director, orchestra member
(playing trumpet and tuba), member and manager of a regional Gospel singing group,
owner of a Gospel music store; representative for the Pennsylvania Council on Alcohol
Problems, interim and supply pastor.
For over 37 years he has worked as a part -time Gospel DJ. In 1971, he earned an FCC
Third Class License with Broadcast Endorsement by passing the written examination.
During 1973-1997 he produced and hosted a Gospel music radio program: Gospel
Caravan. His program was on Internet radio via streaming audio 2000 through 2009.
Ed Lint claims that his most important credential is "a personal relationship with Jesus
Christ. I have accepted Jesus Christ as my sin sacrifice. He is my Lamb of God. The Holy
Spirit fills me. He gives me power to live a successful Christian life and protects me
from Satan and his demons."
He retired in 1994 and has been an educational consultant and primary author of
DiskBooks Electronic Publishing.

